Auswirkungen von Erosionsschutzmaffnahmen auf das Entwicklungsziel ,, Verringerung von
Stoffeintragen (Phosphor)”

Beispielaufgabe 1
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Vorbemerkung;:

Zum derzeitigen Entwicklungsstand des Elbe-DSS liegt ein Software-Prototyp vor, der bereits die wesentlichen Merkmale der spate-
ren Pilot-Version enthalt. Allerdings sind noch nicht alle Funktionalitaten implementiert, was sich in Teilen durch noch nicht imple-
mentierte Dialoge und Mentis oder auch durch Vorabversionen von Ausgabefenstern bemerkbar macht.

Ziel des vorliegenden Prototypen ist es daher, vor allem einen Eindruck der Arbeitsweise und des Look-and-Feel des Elbe-DSS zu
vermitteln. Einen Anspruch auf Vollstandigkeit, Fehlerfreiheit oder Korrektheit aller Ergebnisse kann die vorliegende prototypische
Version jedoch nicht erfiillen.

Um die Funktionsweise und die Arbeit mit dem Elbe-DSS zu demonstrieren wurden zwei Beispielaufgaben formuliert, die von den
Teilnehmern des Nutzertreffens exemplarisch bearbeitet werden sollen.

Aufgabenstellung:

Zur Verringerung der Phosphor-Konzentrationen in den Fliefigewéassern mit Hilfe des Elbe-DSS soll der Effekt und die Wirksamkeit
von verschiedenen Erosionsschutzmafsnahmen untersucht werden.

Durchfithrung;

Die Aufgabe gliedert sich in 3 Teile: Im ersten Teil wird mit dem Elbe-DSS die Ausgangssituation hinsichtlich der Phosphor-
Emissionen sowie die Auswirkungen der Mafsnahme ermittelt. Im (optionalen) zweiten Teil werden die gewonnenen Ergebnisse mit
Hilfe eines Vergleichswerkzeuges kartografisch verglichen. Im dritten Teil werden die Auswirkungen der Mafinahmen auf den Zu-
stand der Fliefsgewasser ermittelt.



Vorgehen:

Aufruf des Elbe-DSS

Nachdem Sie das Pilot-DSS-Programm installiert haben (siehe Installationsanlei-
tung) konnen Sie das Elbe-DSS tiber das Startmenti -> Programme -> Elbe-DSS ->
Elbe-DSS starten. In dem Offnungsfenster (Abbildung 1) wahlen Sie
El beDSS. ei f und dann "Open".

Hinweis: Sollte ElbeDSS.eif nicht angezeigt werden, so wechseln Sie in den Ordner
c:\Programme\ Elbe DSS\data und wihlen Sie dann ElbeDSS .eifl aus!

Die EIF Datei enthalt die Standardeinstellungen des Elbe-DSS. Vorgenommene
Anderungen konnen spéter unter anderem Namen im selben Format gespeichert
werden.

Im nun erscheinenden Fenster (

Abbildung 2) erscheint eine Liste von Modellen, die im Elbe-DSS integriert sind.
Als Enabled markierte Modelle stehen im DSS zur Verfligung. StandardmafSig sind
alle Modelle aktiviert. Diese Auswahl kann iibernommen und mit OK bestatigt
werden.

Hinweis: Um die volle Funktionalitit des Elbe-DSS nutzen zu konnen, miissen alle Model-
le aktiviert sein. Im folgenden wird vorausgesetzt, dass zumindest die Modelle GREAT-ER
und Moneris aktiviert sind.
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Abbildung 1. Auswahl der Datei ElbeDSS.eif nach
Aufruf des Elbe-DSS.
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Abbildung 2. Dialogfenster Auswahl Modelle.

1 Dies setzt vorraus, dass sie das Elbe-DSS im Standardverzeichnis installiert haben. Falls Sie das Elbe-DSS in einem anderen Verzeichnis installiert haben, befin-

det sich die ElbeDSS.eif Datei im bei der Installation angegebenem Verzeichnis im Unterordner data.



1. Teil: Untersuchung des Status quo und Auswirkung einer Erosions-
schutzmafinahme auf die Phosphor Emissionen

Nachdem sie OK angeklickt haben erscheint nach kurzer Wartezeit das System-
diagramm fiir das Elbe-DSS (Abbildung 3). Das interaktive Systemdiagram dient
der Steuerung des Elbe-DSS. Wenn Sie mit der Maus tiber die vier Teilmodule fah-
ren werden diese jeweils schwarz hinterlegt. Sie konnen nun das Modul Einzugs-
gebiet auswahlen, indem Sie das Modul anklicken.

Es erscheint das detaillierte Systemdiagramm fiir das Einzugsgebiet (Abbildung 4).
Dieses neue Fenster enthalt fiir das Modul Einzugsgebiet die im Elbe-DSS abgebil-
deten Systemelemente, wie zum Beispiel die Gebietseigenschaften Niederschlag,
Topographie, Landnutzung, usw. oder die Abflusskomponenten Oberflachenab-
fluss, Infiltration usw. Falls Sie auf eines der Systemelemente anklicken (z.B.
Landnutzung) erhalten Sie bereits in dieser Version zusatzliche Informationen in
Form von Karten oder dhnlichem — in der Endversion werden hier zu allen Ele-
menten Informationen vorliegen.
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Abbildung 3. Systemdiagramm und Auswahl des
Moduls Einzugsgebiet.
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Abbildung 4. Detailliertes Systemdiagramm des
Moduls Einzugsgebiet



Beachten Sie bitte auch (oben) die Reiter des Fensters:
System

- Ext. Szenarien

- Mafinahmen

Entwicklungsziele

Uber diese Reiter gelangen Sie zu den Systemelementen, die Zugang zu den we-
sentlichen Eingabe- und Ausgabedialogen fiir die Arbeit mit dem Elbe-DSS bieten.

Die normale Vorgehensweise bei der Arbeit mit dem Elbe-DSS besteht darin, zu-
nachst ein Entwicklungsziel auszuwahlen. Gehen wir in unserem Beispiel zu-
nachst davon aus, dass Sie das Entwicklungsziel , Verringerung von Schadstoffein-
tragen” verfolgen wollen. Offnen Sie hierzu den Reiter Entwicklungsziele
(Abbildung 5) und klicken auf den Kasten , Verringerung von Schadstoffeintra-

"

gen”.

Es erscheint ein Ergebnisdialog, der den derzeitigen Status fiir dieses Entwick-
lungsziel darstellt (Abbildung 6).

Hinweis: Der Dialog ist zundchst nicht initialisiert. Die Anzeige wird erst berechnet,
wenn Sie in der Substanzliste eine Anderung vornehmen.

Uber das Listenfeld ,Substanz” wiahlen Sie hier ,Phosphor” aus. Mit der Auswahl
aktualisiert sich sofort der Fensterinhalt. Wie der Darstellung zu entnehmen ist,
belduft sich die Phosphorfracht fiir das deutsche Gesamteinzugsgebiet auf etwa
6850 t/a, von denen der grofite Teil {iber die Bodenerosion eingetragen wird, ge-
folgt von dem Eintrag tiber Punktquellen, urbane Flachen und Grundwasser.

Hinweis: Der Knopf Karte liefert erst nach dem ersten Simulationslauf eine Darstellung.
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Abbildung 5. Auswahl des Entwicklungszieles
»Verringerung von Stoffeintrigen” im Modul Ein-
zugsgebiet.
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Abbildung 6. Darstellung des Status-Quo fiir das
Entwicklungsziel , Verringerung von Phosphorein-
tragen”



Ein Klick auf den Button ,,Karte” dffnet ein Ergebnisfenster (Abbildung 9), das die raumli-
che Verteilung der Phosphoreintrige fiir die Teileinzugsgebiete anzeigt. Bevor die Karten-
ansicht verfiigbar ist, muss jedoch ein erster Modelllauf durchgefiihrt werden.

Das Starten des Modellaufs geschieht tiber den Mentipunkt Simulation -> Starten
(Abbildung 7).

Hinweis: Ist der Meniipunkt Start ausgegraut, liegt dies daran, dass die Simulation bereits
vorgenommen wurde und keine Anderungen erfolgt sind, die eine erneute Simulation er-
fordern. In diesem Fall sollten die Ergebnisse vorhanden und die nachfolgenden Arbeits-
schritte ohne nochmalige Simulation zu erledigen sein.

Ein Kommandozeilenfenster 6ffnet sich, in dem der Fortschritt der Simulation ver-
folgt werden kann (Abbildung 8).

Hinweis: Bitte unterbrechen Sie die Simulation nicht, da dies das Elbe-DSS in einen nicht
definierten Zustand versetzt. Sollten Sie aus irgendwelchen Griinden gezwungen sein, die
Simulation abzubrechen, starten Sie das Elbe-DSS bitte neu.

Die Simulation kann je nach eingesetztem Rechner zwischen 2 und 4 Minuten in An-
spruch nehmen.
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Abbildung 7. Starten einer Simulation.
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Abbildung 8. Der Simulationsfortschritt wird in

einem separatem Fenster angezeigt.

Nun kann die Verteilung der Phosphor-Emissionen im Elbe Einzugsgebiet betrachtet werden. Driicken Sie hierzu den Knopf ,Karte”
im Dialog Verringerung von Stoffeintragen (Abbildung 6). Als Ergebnis erhalten Sie eine georeferenzierte Darstellung der

Phosphoremissionen (Abbildung 9).

Die hochsten Werte im deutschen Elbe-Einzugsgebiet finden sich in den Mittelgebirgsregionen sowie den Tide beeinflussten Teilein-

zugsgebieten am Unterlauf der Elbe.

Die Legende befindet sich im linken oberen Teilfenster, darunter befindet sich das Ubersichtsfenster. Auf der rechten Seite befindet
sich oben die Liste der im Viewer enthaltenen thematischen Ebenen, wahrend sich darunter verschiedene zu Gruppen zusammenge-

fasste Werkzeuge befinden.



Der Karten-Viewer (Abbildung 9) findet an verschiedenen Stellen des Elbe-DSS Verwendung, seine Benutzung wird im weiteren Ver-
lauf der Aufgabe weiter unten beschrieben.
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Abbildung 9. Kartendarstellung des Status-Quo fiir das Entwicklungsziel ,, Verringerung von Stoffeintrigen” am Beispiel der Phosphatemis-
sionen.

Wir werden den Referenzzustand spater noch einmal bendtigen, um Verdanderun-

gen dazu zu betrachten. Hierzu ist es notig, dass Sie das Ergebnis tiber Grid Ope- [ Gid operaions
rations -> Save Grid (Abbildung 10) an einem geeigneten Ort ab speichern Pen
(Abbildung 11). Die Werkzeuggruppe , Grid operations” befindet sich im rechten =
unteren Fensterbereich des Map Viewers.

Inspect

Save Grid
|

Hinweis: Wurde ein Fensterbereich des Map Viewers, beispielsweise der Werkzeugbereich |
versehentlich geschlossen, kann er durch Schlieflen und anschliefendes erneutes Offnen der
Karte wieder hergestellt werden.

Abbildung 10. Der Grid operations Reiter dient
unter anderem zum Speichern von Rasterdatenkar-
ten.
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Nun mochten Sie die Auswirkungen der Erosionsschutzmafinahmen fiir dieses
Entwicklungsziel untersuchen: gehen sie auf den Reiter ,MafiSnahmen” und wah-
len Sie die Mafsnahme , Landwirtschaftliche Praxis” durch einfachen Klick aus
(Abbildung 12).
Hinter der Mafinahme , Landwirtschaftliche Praxis” verbirgt sich ein ganzes Maf3-
nahmenbtindel: es erscheint ein weiteres Fenster mit diesen Einzelmafnahmen  Appildung 13. EinzelmaBnahmen des Mafnah-
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Wahlen Sie Erosionsschutz (Abbildung 13) durch einen Mausklick auf dieses Sys-
temelement. Nun konnen Sie auswéhlen (Abbildung 14), welche der folgenden
Erosionsschutzmafsnahmen (auch mehrere auf einmal) Sie betrachten mdochten:

* Umstellung auf , Konservierende Bodenbearbeitung”: Erhohung der Bodenbede-
ckung durch so genannte “Konservierende Bodenbearbeitung” (Mulchsaat, Zu-
riicklassen von Erntertickstinden auf dem Feld, nur oberflachliches Pfliigen).

* Konturnutzung: Bewirtschaftung von Ackerflachen parallel zu den Konturlinien
des Hanges.

» Streifennutzung: Bewirtschaftung von Ackerflichen in Streifen mit Erosionsfor-
dernden und -hemmenden Kulturarten im Wechsel.

Zunichst legen Sie den Raumbezug fest: soll die Mafinahme fiir das ganze Ein-
zugsgebiet, ein Teileinzugsgebiet oder einen Koordinierungsraum gelten? Wéahlen
Sie in unserem Beispiel ,,Gesamteinzugsgebiet”.

Weiterhin konnen Sie mit dem Schieberegler festlegen, welcher Anteil der land-
wirtschaftlichen Nutzflache umgestellt werden soll. Wahlen Sie einen Anteil von
20% Prozent, die auf konservierende Bodenbearbeitung, Konturnutzung und Strei-
fennutzung umgestellt werden sollen. Die Kammhohe bleibt bei ,> 12,5 cm”.

Die Anderungen werden sofort iibernommen, miissen also nicht durch OK besta-
tigt werden. Schliefien Sie den Dialog wieder.

Damit die Auswirkungen der Mafinahme berechnet werden kénnen, muss erneut
ein Simulationslauf durchgefitihrt werden. Betdtigen Sie Simulation -> Start
(Abbildung 7).
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Abbildung 14. Auswahl der Erosionsschutzmaf-
nahme. Stellen Sie eine Erhohung der konservie-
renden Bodenbearbeitung, der Konturnutzung und
der Streifennutzung um jeweils 20% ein. Sie kon-
nen den eingestellten Wert anhand der gelben
ToolTip Anzeige nachverfolgen, die erscheint, so-

bald sie den Schieberegler verandern.




Auswirkung der Mafinahme auf die Phosphor Emissionen

Wechseln Sie in das Fenster , Verringerung von Schadstoffeintragen” (Abbildung 5
Abbildung 6)und betrachten Sie das Ergebnis.

Das Fenster finden Sie im Modul Einzugsgebiet, Reiter Zielvorgaben, Systemele-
ment , Verringerung von Stoffeintragen”.

Im Vergleich zum Referenzzustand hat sich die Gesamtmenge der Phosphor Emis-
sionen um etwa 350 t/a verringert. Diese Abnahme ist ausschliefilich auf den Pfad
Erosion zurtick zufiihren. Entsprechend hat sich der Anteil dieses Pfades an der
gesamten Phosphor Emissionsmenge um 4 Prozentpunkte abgenommen.

Hinweis: Die Ergebnisdarstellung wird automatisch aktualisiert, auch wenn der Dialog
noch gedffnet ist. Sollte dies nicht der Fall sein, schliefSen Sie den Dialog bitte und offnen
ihn erneut.

Mit dem bisherigen Vorgehen sind die Auswirkungen der Beispielmafinahme Ero-
sionsschutz zwar vollstaindig berechnet worden, ein Blick auf die Karte
(Abbildung 16) zeigt jedoch, dass die die raumliche Verteilung der Abnahme nicht
einfach zu erkennen ist. Deswegen werden wir weitere Analysewerkzeuge heran-
ziehen, um die Unterschiede herauszuarbeiten.

Speichern Sie das Ergebnis tiber Grid Operations -> Save Grid (Abbildung 10) an
einem geeigneten Ort ab (Abbildung 11).

Hinweis: Die nun folgende Aufarbeitung der Ergebnisse dient nur der Herausarbeitung
der regionalen Effekte der Mafinahme und stellt lediglich eine kartenorientierte Weiterver-
arbeitung dar.
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Abbildung 15. Darstellung des Effektes der Erosi-
onsschutzmafinahmen fiir das Entwicklungsziel
»Verringerung von Phosphoreintragen”.
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Abbildung 16. Kartendarstellung der Phosphateintrige nach Wirksamwerden der Erosionsschutzmafinahmen

2. Teil: Untersuchung der Verinderungen im Map Comparison Kit

Die Veranderungen lassen sich durch einen einfachen optischen Vergleich der Kar-
ten nicht eindeutig feststellen. Um diese Unterschiede herauszuarbeiten wird das
Map Comparison Kit verwendet.

Hinweis: Momentan liegt das Map Comparison Kit als externes Werkzeug vor. Eine Integ-
ration des Werkzeuges in das DSS ist geplant.

Starten Sie das Map Comparison Kit tiber Start -> Programme -> Map Comparison
Kit -> Map Comparison Kit (Abbildung 17).
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Abbildung 17. Das Starten des Map Comparison

Kits geschieht iiber das Start Menii.

B

aaaaaaaa

eeeeeeee

nnnnnnnnn

& of B

Abbildung 18. Beenden Sie den ersten Open Dialog
iiber "Abbrechen".
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Nach dem Starten des Werkzeuges werden Sie aufgefordert ein Log File zu 6ffnen
(Open Dialog, Abbildung 19). Verlassen Sie diesen Dialog durch , Abbrechen”, da
wir dieses Log File zundchst erstellen miissen.

Nachdem das Map Comparison Kit geladen ist, miissen die zu vergleichenden Da-
ten eingetragen werden. Dies geschieht tiber den Mentipunkt ,File -> New”. Es
erscheint der Edit Log File Dialog (Abbildung 19).

Das Log File dient dem Verwalten von (Raster-) Datensitzen, die im Map Compa-
rison Kit miteinander verglichen werden sollen. Datensatze, die miteinander ver-
glichen werden sollen, miissen sich innerhalb eines Themas befinden. Momentan
befindet sich lediglich ein leeres Thema innerhalb des Log Files. Klicken Sie es mit
der Maus an und geben Sie dem Thema tiiber den , Rename” Knopf einen aussage-
kraftigen Namen (z.B. exerciseErosionsschutzmassnahme). Bei der Namensverga-
be miissen Sie auf deutsche Umlaute und andere Sonderzeichen verzichten.

Benutzen Sie anschliefend den , Import” Button um nacheinander die beiden Da-
tensitze zu laden, die Sie im Verlauf der Ubung bisher erzeugt haben (Abbildung
20).

Tragen sie als ,Region map” (Eingabefeld am unteren Rand des Dialoges) die Da-
tei C:\programme)\elbedss\data\maps\teileinzugsgebiete\ moneris_tezg500.img
ein. Uber den Knopf | gelangen Sie zu einem Datei Auswahl Dialog. Diese Datei

dient lediglich der besseren Darstellung. Durch sie sind die einzelnen Teileinzugs-
gebiete besser voneinander abzugrenzen.

Edit Log File

E

News theme

Reqgion map

Add Therne
Import...
Remave
Rename

[
oo

Legends. ..

J Cancel

Abbildung 19. Im Map Comparison Kit zu analysie-
rende Daten miissen zunichst im Log File eingetra-

gen werden.
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Abbildung 20. Das Importieren der Daten in ein
Thema ist notwendig, bevor die Analyseschritte
durchgefiihrt werden kénnen.

12



Anschliefiend sollte ihr Log File dhnlich wie in Abbildung 22 aussehen.

Hinweis: Wiihlen Sie als Dateityp ,ldrisi Image Files (*rst, *img) aus, da die Dateien in
diesem Format vom Elbe-DSS gespeichert werden.

Zum Speichern des neu erzeugten Log Files werden Sie nach Betatigen des ,,OK”
Knopfes aufgefordert (Abbildung 21). Ein neu erzeugtes Log File muss gespeichert
werden, bevor weitere Analyseschritte durchgefiihrt werden konnen. Legen Sie
das Log File am besten im selben Verzeichnis wie die zu analysierenden Datensat-
ze ab.
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Abbildung 21 Ein neu erzeugtes Log File muss gespeichert werden, bevor die Analyse-
schritte durchgefiihrt werden kénnen

Edit Log File

X

—I- exerciseErosionsschutzmassnahme
..\exercise_grosionsschukzmassnabmelgrosionZ0_20_20.img
..\exercise_grosionsschukzmassnabmeirel_p.img

Region map

|C:'l,programme'l,elbedss'l,data'l,maps'l,teiIeinzugsgebiete'l,moneris_l J

add Theme
Import, ..

Rename
T
[

Legends...

]

o]

K
Cancel

Abbildung 22 Das Log File nach Laden der beiden
Dateien und setzen der Region map.

Die weiteren Arbeitsschritte werden Sie mithilfe der Toolbar des Map Comparison Kits durchfiihren. Die wichtigsten Elemente der

Toolbar sind in Abbildung 23 dargestellt.

Hinweis: Sollten Sie das Log File im Laufe der Ubung nochmals verindern wollen, verwenden Sie den Meniipunkt , Edit -> Log file” oder den ent-

sprechenden Button der Toolbar.
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Aktuell im Einsatz befindliches
Thema des aktuellen Log Files.

T — R S w:”3” iililbB — ¥,
Iﬁ B & ElbeDs Slebungl | 1| \ewercise_amsionssohutzmassnahmetiel_pi v | 2 [ SHeice. Slonssehuemasenahme elsin ~ | | £t 1z ]

Editieren des

el T el Erster und zweiter Datensatz, die Einstellen und
aktuetlen Log Tiles miteinander verglichen werden Anzeigen der
sollen. Die Anzeige geschieht tiber Analysefunktionen

die Knépfe 1und 2
Abbildung 23. Die wichtigsten Elemente der Toolbar des Map Comparison Kits.

Stellen Sie zundchst sicher, dass das von Thnen eben erstellte Thema in der ersten Drop-Down Liste eingestellt ist. Wahlen Sie in den
nachsten beiden Drop-Down Listen den Datensatz, der den Referenzzustand reprasentiert und anschliefend den Datensatz, der die
Situation nach Anwenden der Mafsinahme darstellt (Abbildung 24).

|EIbeDSSUebung1 j 1 |...'\e:-:ercise_erDsiDnsschutzmassnahme\ref_p.ij 2 |§...'\e:-:ercise erDsionsschutzmassnahmekerosioréﬂ

Abbildung 24. Die drei Drop-Down Listen der Toolbar dienen zum Einstellen des Themas und der beiden Datensitze, die miteinander ver-

1

glichen werden sollen. Die Knépfe und ‘2 dienen der Anzeige der Datensitze.

Nachdem Sie diese Einstellungen vorgenommen haben, betitigen Sie die Kndpfe 1 und % um die Datensétze darzustellen (falls
dies noch nicht geschehen ist).

Als Ergebnis erhalten Sie eine Darstellung der Phosphatemissionen beider Zustande, die — mit Ausnahme der Legende - der im FElbe-
DSS dhnelt. Abbildung 25 zeigt dies beispielhaft fiir den Referenzzustand. Bei der Darstellung wird standardmafiig eine andere als
die dargestellte Legende verwendet, dies bleibt fiir die Auswertung jedoch ohne Relevanz.

Die Anzeigefenster des Map Comparison Kits dhneln dem Map Viewer des Elbe-DSS. Links oben befindet sich die Legende, links un-
ten das Ubersichtsfenster und rechts das Detailfenster.
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2]

. log - [ \exercise_erosi fon20_20_20.img] NEX¥]
T el £t vew Cptions Wrdon tob BEE

FEANY- il ] 4 [Cermne ] 2 [CNermne i) |1 5 12

1 395.00 . 400.00
[390.00 .. 395.00
(38000 ... 390.00

370,00 .. 300.00

[ 360.00... 370.00
[ 350.00 ... 360.00
[340.00 ... 350.00
[1330.00... 340.00
(1320.00 ... 330.00
310,00 32000
C1300.00 .. 310.00
CJ270.00... 300.00
D240.00...270.00
[J1210.00 ... 240.00
[180.00 ... 210.00
150,00 180.00
[ 120.00 ... 150.00
D 90.00... 120.00

[l 50.00 ... 90.00 . -
Wo00...50.00 Comparisons and other operations .%
000 ... 0.00
C tegori
ompare calegqornes
" Per categary
 Cellby cell _ Coreal|

" Fuzzy Inference System algorithm

" Fuzzy Set algorithm

Compare numerical values

al >

— e o ™ abs[ second - first
Abbildung 25. Phosphoremissionen im Referenzzustand in Tonnen pro Jahr - [Se[cmd_ﬁ,st] ,;ak[abs[smnd_ﬁ,s”]
und Einzugsgebiet. ™ abs( second - first ] # max( abs( second - first )
" zecond / first
Wahlen Sie iiber den Menitipunkt ,Options -> Comparison Method” ,,second — 9 ol s i

NODATA

first” aus um die absoluten Veranderungen zwischen beiden Zustanden in t P / a
" ANODATA %) = NODATA (+ [NODATA %) = F0.2]

zu erhalten (Abbildung 26).

Other operations

Stofien Sie anschlieffend mit ,Options -> Result Map” die Berechnung des Ergeb- " fist + second
nisses an. Als Ergebnis erhalten Sie die Darstellung der Differenzen zwischen bei- st
den Zustdnden. In unserem Fall handelt es sich um die Abweichungen in Tonnen
Phosphor Emission pro Jahr und Einzugsgebiet.

1.

" first *

Abbildung 26. Im ,,Comparisions and other opera-
Es ldsst sich schnell erkennen, dass alle Veranderungen negativ sind, die Phos- tions” Dialog kann die fiir den Vergleich zu benut-
zende Methode ausgewihlt werden. Wihlen Sie

phoremissionen somit in allen Einzugsgebieten abgenommen haben. Weiterhin
zunichst ,,second - first” aus.

lassen sich die Gebiete der absolut grofiten Reduktion ausmachen.
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Die Werte sollten von 0 bis etwa — 20 reichen. Falls die Legende einen anderen Bereich darstellt, vergewissern Sie sich, ob Sie die richtigen Daten-

sitze ausgewdhlt haben und ob die Reihenfolge der Datensitze mit der in der Aufgabe beschriebenen Reihenfolge iibereinstimmt (sind die Datensiit-
ze vertauscht, dndert sich das Vorzeichen).

Falls die Datensitze korrekt eingetragen sind und die Legende nicht den gewiinschten Bereich darstellt, doppelklicken Sie im Bereich der Legende.
Der Legendeneditor (Abbildung 27) dffnet sich.

Hier konnen Sie die Legende ihren Bediirfnissen entsprechend anpassen:

» Stellen Sie die Anzahl der Klassen (N Classes) auf 11

* als untere Grenze (Min) sollte -20, als obere Grenze (Max) 0 eingegeben werden
* als Palette verwenden Sie , negativ.smp”,

Legend editor - [ElbeDSSUebungminus diff.txt]

Palette settings m

D iz U Top of legend iz _

[ -3s4... 182 Palette |negative.smp | | & Palette colar 1 ¢ Palette colar N Cancel

[]545.. 364

D .27 .. -5.45 Palette editar Start... M Calars

s, 727

(091909 Ll

D 4273109 " Categoric * Mumeric M Classes |11

D e et Mumeric legend settings

l:‘ S1B3E 1455 Display interval Murnber format
M 11z 1636 Min |-20 Max |0 Decimals |2 Hirts...
| Bl " Laoale
+ Linear scale » s
~
" Hi
" Custom scale
Lo+ Hi2
Top legend is
" Digplay Max € Custom
" Dizplay Min ¢ La..Hi

Apply

Abbildung 27. Der Legendeneditor des Map Comparison Kits wird nur benétigt, falls die Legende nicht den gewiinschten Bereich darstellt.
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mEs]

Abbildung 28. Darstellung der Verinderung der Phosphoremissionen in Tonnen pro
Jahr und Einzugsgebiet

Der néchste Schritt ist es, die relativen Anderungen zu vergleichen. Absolute Wer-
te konnen hinsichtlich der Wirksamkeit der Mafinahme tduschen; eine Reduktion
um 10 Tonnen pro Jahr kann bei einer Gesamtemissionsmenge von 20 t/a sehr be-
achtlich sein, wéahrend sie bei einem Ausgangswert von 1000 t/a eher bescheiden
ausfallt.

Relative Anderungen lassen sich mit der Option ,second / first” darstellen
(Abbildung 29). Der zugehorige Dialog ist iiber , Options -> Comparison method”

(hier negativ sind), konnen wir auch die Option ,abs ( second / first )* verwenden,
die die Absolutwerte der relativen Anderungen ausgibt. Der Vorteil dieser Metho-
de liegt in einer tibersichtlicheren Legendeneinteilung.

Comparisons and other operations

" Fuzzy Inference Spstem algorithm

" Fuzzy Set algorithm

Compare nurmerical values

™ second - first

" abs( second - first )

" [ zecond - first | # max( abs( second - first ]

" abs( second - first ) / maw( abs( second - first J)

™ second / first

" ANODATA, %) = NODATA f* FNODATAx) = f(0.x%)

Other operations
" first + second

™ first +

il

" firgt*

Compare categories
" Per categary
 Cellby cell Caize]

Abbildung 29. Um die relativen Anderungen zu

erreichbar. Da in unserem Beispiel alle Anderungen in die selbe Richtung weisen betrachten wird die ,second / first” Methode einge-

setzt. Da alle Werte unseres Beispiels kleiner Null
sind, kann auch der Absolutwert ,abs ( second /

first ) verwendet werden.
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Die Werte sollten in einem Bereich von 1 bis etwa 0.8 liegen. Falls die Legende etwas anderes anzeigt, vergewissern Sie sich bitte, dass sie die rich-
tigen Datensitze verwenden und auch die Reihenfolge korrekt ist (falls die Datensitze vertauscht wurden, sollte sich der Wertebereich zwischen 1
und 1.25 befinden). Vergewissern Sie sich noch einmal, dass die richtige Methode ausgewdihlt wurde.

Konnen Sie den Fehler so nicht beheben, offnen Sie bitte durch Doppelklick iiber der Legende den Legendeneditor.
Verwenden Sie in diesem Fall folgende Einstellungen:

*  Dalette ,positive.smp”

* Top of legend is , Palette color N
e Anzahl Klassen (N Classes) 6

e Min0.8 Max1

Legend editor - [ElbeDSSUebung1absreldifflocal.txt]
D 097100 Palette settings . -
Top of legend is
Loz 0w Palette |pasitive.smp *| | Palettecolor? ¢ Palette color M Cancel
oo, 093
|:| 0.87..0490 Palette editar Start... M Colors ’—
[loss..0s7
[oso.. 083 el
" Categoric * Mumeric M Classes |6
Mumeric legend settings

Dizplay interval MNurber farmat

Mir |08 Maw |1 Decimals |2 Hirts...

Scale Labels

(¢ Linear scale » (Lo

~

" Hi
™ Custam scale
" [Lo +Hil#2

Top legend iz

* Display Max € Custom

" Display Min &+ Lo.. Hi

Abbildung 30. Der Legendeneditor des Map Comparison Kits wird nur benétigt, falls die Legende nicht den gewiinschten Bereich darstellt
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Abbildung 31. Relative Phosphatemissionen. Dargestellt ist der Absolutwert des Quotienten aus Referenzzustand und Zustand nach Wirk-
samwerden der Erosionschutzmafinahme. Helle Farben entsprechen stiarkeren relativen Abnahmen.

3. Teil: Auswirkung der Mafsnahme auf den Zustand der Fliefigewdisser e )

Sustem ] MaBnahmen Entwicklungszisle

Im dritten Teil dieser Aufgabe sollen die Auswirkungen der Mafsnahme auf den
Zustand der FliefSigewdsser untersucht werden. Gehen Sie hierzu zuriick zum Sys-
temdiagramm (Abbildung 3) und wihlen Sie das Modul FlieSgewissernetz aus. s Flonorssniie
Im Reiter ,Entwicklungsziele” (Abbildung 32) sind die Entwicklungsziele , Guter
okologischer Zustand des FliefSgewdssernetzes (Gewassergtite) nach EU-WRRL”
und , Verringerung der Stofffrachten in die Nordsee” z.Z. noch nicht implemen-

erringerung d.
Stofffrachten

Georeferenziarter in die Nordees
Durchflugs im Gerinne

i \—>
tlel‘t. Extremabflissen

Abbildung 32. Entwicklungsziele im Modul Flief3-
gewdssernetz
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Wir wollen im folgendem von den Systemelementen ausgehen; wechseln Sie zum =
Reiter ,System” (Abbildung 34). Uber das Systemelement ,, Transport, Elimination _Sy:::srj:;::;:r]‘eg:twickmngsziae] Jokd
und Transformation von Nahr- und Schadstoffen” gelangen Sie zur Auswahl der

im Folgenden zu simulierenden Substanz (Abbildung 33). Wahlen Sie Phosphor I och] Enugegebie ]| e mEliminamn¢

aus und schlielen Sie den Dialog wieder. Digalas R e
Gewissernetzwerk Abflussge-

| e

E Substanz Management E] [Konzentrationen

Abfluss- — X -
statistik {Einleiterstellen [Sedimentation &
Substanzen: Resuspension

Ammanium o L 4 s _
Eor Georeferenzierter Stofffrachten in
Diclofenac Durchfluss im Getinne den Hauptstram
Paracetamal " Ly, ST e
4 odul Hauptstrom
RIS | Zufluss in den[ £
Maodul Flussabschnitt

I{_

|

Hauptstrom

Abbildung 34. Im Reiter System des Moduls Fliess-
gewdssernetz konnen die zur Abschitzung der

Auswirkung der Erosionsschutzmafinahmen auf
Abbildung 33. Zur Auswahl der zu simulierenden Substanz gelangen sie iiber das Sys-  jen Zustand der Fliessgewisser benotigten Einstel-

temelement ,Transport, Elimination und Transformation von Nihr- und Schadstoffen”. lungen getroffen werden.
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Uber das Systemelement ,, Konzentrationen” konnen Sie mit einem einfachen Klick
jedoch einen Eingabedialog fiir eine Ergebnisdarstellung 6ffnen (Abbildung 36)

Kontrollieren Sie, ob Phosphor als Substanz erscheint und betéatigen Sie den Button
,Karte” um eine Kartendarstellung der Konzentrationsverteilung im gesamten
Fliefigewdssernetz zu bekommen (Abbildung 35).

Dargestellt sind die Konzentrationen im Fliesgewassernetz (Liniensegmente) und
die Punktquellen (Punkte), die neben den diffusen Emissionen als Input in die
Gewdsser betrachtet werden miissen. Im Vergleich zu den Emissionen aus dem
ersten Teil der Aufgabe betrachten wir nun die Immissionsseite.

Punktquellen - Phosphor (Konzentrationen Punktquellen) (1:4.58856e+006) E]@
. x

Schadstoffkonzentration - Phaspha

x

Link color | Link width | Nodes |

Il > 012500 [mgA]

[ 007000 - 0.125 [mg]
[ 0.05000 - 0.07 [ma/l
[[] 0.03000 - 0.05 [mg/1
[ 0.02- 0.02 [mgA]

[ oot - 002

[l - 0.0 [maA]

Zoom operations

Metwark operations

Print

Abbildung 35. Karte der Stoffkonzentrationen im gesamten Flie3gewidssernetz

Hinweis: sollten Sie das Elbe-DSS zwischenzeitlich geschlossen haben, miissen Sie zu-
ndchst eine Simulation starten, bevor Sie die Karte ansehen konnen.

£ Konzentrationen E] O

Substanz

(* ¥onzenkration am Anfang des Segments

(" Mittlere Konzentration im Segment

(" Konzenkration am Ende des Segments

Konzentrationsyerauf

summenhaufigkeiten

[

Flusssegment # 1]
konzentration [mg)l] 0

Strecke [km) a0 Diagrarmm

Diagramm
karte

Abbildung 36. Eingabedialog fiir die Ergebnisdar-
stellung der Konzentrationen
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Uber die Auswahl der Schaltflaiche ,Zoom Operations” im rechten Teil des Fens-
ters kann der Ausschnitt verandert werden (Abbildung 37a). Benutzen Sie hierzu
den Button J, um einen beliebigen Ausschnitt zu vergroiern. Mit den Buttons
, a| kénnen Sie in die Karte hinein- oder herauszoomen, der Button 2 stellt den
gesamten Kartenbereich dar und der Button $?| erlaubt das Verschieben der Karte.

Um nun ein Konzentrationsprofil eines beliebigen Flussabschnittes darzustellen
gehen Sie wie folgt vor: Zoomen Sie wie oben beschrieben in den Bereich der Kar-
te, die den Anfangsflussabschnitt des gewtiinschten Profils zeigt (z.B. den Quellbe-
reich eines Flusses”. Aktivieren Sie den Layer Schadstoffkonzentrationen — Phos-
phor (die Schrift erscheint dunkel hinterlegt). Offnen Sie die Schaltfliche ,Net-
work Operations” im rechten Teil des Kartenfensters (Abbildung 37b) und klicken
den Button , Select/Edit”. Klicken Sie nun in die Karte auf den gewtinschten Fluss-
abschnitt; der selektierte Abschnitt erscheint rot.

a

[&] & 7| 2|
Apply J

Tin Dperations

| Metwork operationz | |

x Select/edit

Calor master figld:

CINT AL A
Lirre: width mazter field:
CEMD_DIST -
™ Shaw nodes

v Show links ‘
1

Abbildung 37. Zoom und Network Operations im

.
MapViewer.
fon - Phosphor i (1:391914) ===
* L7 [ s = j 3 ]
Lirk coler | Link wich | Nodes | {5 )\ s .
- -
[l > 012500 g/ o —/7 N - S gAY o 4 /‘L N Punkiquellen - Phosphor
[ 0.07000 - 0125 [mg/] = 7oAy A
T
[ ©.05000 - 0.07 [mal T AN WA N b
[] 0.03000 - 0.05 [mg] = TS
[ 002 - 003 [mg/1) /f\ R
[ oo 0oz o iy
[ - 0.01 [marl =
Select/edt
Color maste fild
CINT_WaL -

<

Line width master field:

~
o CEND_DIST -
3 |

Abbildung 38. Die Auswahl des Flussabschnittes,
von dem aus die Konzentrationen bis zur Miindung
abgetragen werden geschieht im Map Viewer.
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Wenn Sie nun in das Fenster Konzentrationen wechseln sehen Sie, dass ein Flufs-

segment ausgewahlt wurde (Abbildung 40). Tragen Sie nun fiir den Konzentrati- E] Konzentrationen =)
onsverlauf die Strecke ein, fiir die das Profil bestimmt werden soll (in diesem Fall Substanz
150 km) und betdtigen Sie den Button , Diagramm®. Es erscheint das Konzen- | =]

trationsprofil fiir den ausgewahlten Flussabschnitt (Abbildung 39)

(" Kaonzenkration am Anfang des Segments

— {* Mittlere Konzentration im Segrmenti
—_ Diagramm E] ;
(" Konzentration am Ende des Segments
A @ Q 3D % % (=} W — Seriesl Flusssegment # | 241733
_ Konzentration [majl] | 0.0233586
. Konzentration won
10 : : : : : : Konzentrationsyerlauf
Strecke [km] 650 Diagramm
=
g g summenhaufigkeiten
[
% : : : : : : Diagrarnn
= i i i i i i
H o 1 1 1 1 1 1
R e e BELCLL L ipaEEELELD e e L C L Karte
(=} 1 1 1 1 1 1
= i i i i i i
! ! ! ! ! ! Abbildung 40. Konzentrationsdialog nach Auswahl
-1 i i i i i i
1o S [ [ [ [ eines Flusssegmentes iiber die Karte .
u] 100 200 300 400 00 B0
Streckelkm]

Abbildung 39. Konzentrationsdiagramm fiir den ausgewdhlten Flussabschnitt

Um die Ergebnisse mit dem Referenzzustand vergleichen zu konnen, setzen Sie die Erosionsschutzmafinahme zurtick und starten Sie
die Simulation nochmals.

Hierzu wahlen Sie im Mafsnahmen Reiter des Einzugsgebietsmoduls (Abbildung 5) das Mafsnahmenbiindel , Landwirtschaftliche Pra-
xis” aus klicken dann die Mafinahmen ,,Erosionschutz” an und wahlen zuriicksetzen. Starten sie anschlieSend die Simulation neu.
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Punktquellen - Phosphor (Konzentrationen Punktquellen) (1:4.58856e+006 ) g@

=

b3

Lirk calar | Lirk. width I Nodes I S chadstoffkonzentration - Phosphal

Il > 012500 [mg/]

[ 0.07000 - 0125 [mg/1]
[ 0.05000 - 0.07 [mgA]
[[] 0.03000 - 0.05 [mg]
[] 0.02- 0.03 [mg/1

] o1 -0z

I o- oo mall

Zoom operations
VY el
Apply | _|

[Grnid operations

Metwaork operations

I o o T e
L = N ] — ]

Tir Dperations

— =

Abbildung 41. Phosphorkonzentrationen im Fliessgewidssernetz ohne Wirkung von Mafinahmen (Referenzzustand)

Ein Vergleich der Phosphor Konzentrationen im Fliessgewdsser zeigt, dass die gelb und orange dargestellten Klassen vor Einsatz der
Mafinahme deutlich starker — auf Kosten der griin dargestellten Klassen - vertreten sind. Die Mafsnahme hat in weiten Bereichen zu
einer Reduktion der Phosphor Konzentrationen im Fliessgewdsser gefiihrt, wobei der Mittelgebirgsbereich die deutlichsten Verande-

rungen zeigt.

Wenn Sie erneut den , Diagramm®“-Knopf im Konzentrationen Dialog benutzen, wird das neue Konzentrationsprofil in den bereits
vorhandenen Grafen eingezeichnet, so dass sie die Unterschiede gut erkennen konnen (Abbildung 42). Der Diagramm Dialog bietet
zahlreiche Einstellungsmoglichkeiten, die jedoch den Rahmen der Ubung sprengen wiirden.
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| Diagramm E]
<A way @ E i .E.X_i. % ﬂ Zoom: 99 % [ == Feferenzzustand

[y s b alinabime Erosionsschutz 21

Fhosphorkonzertrationen [uo] vom Flusssegment 241733 sb
280

260

240

220

200

Konzentration [pgd]
o = = B =2 T 2
3 2 &8 8 & & &8

=
=

5
=

o a0 100 150 200 250 300 350 400 450 500 550 E00 650
Streckelkm]

Abbildung 42. Vergleich der Konzentrationsprofile von Phosphor vor und nach Wirksamwerden der Erosionsschutzmafinahme.

Ausblick

Nachdem Sie sich nun einen Uberblick iiber die Funktionalitit des Elbe-DSS verschafft haben, versuchen Sie doch einmal, die Wir-
kung der Erosionsschutzmafinahme mit den Wirkungen einer Anderung des Anschlussgrades zu vergleichen. Die entsprechenden

Einstellungsmoglichkeiten finden Sie im MafSnahmen Reiter des Moduls Einzugsgebiet im MafiSnahmenbiindel ,, Kommunale Abwas-
serereinigung”.

Beenden der Anwendung

Das Map Comparison Kit kann nun beendet werden (File -> Exit). Falls Sie die Anderungen im Elbe DSS speichern méchten, tun Sie

dies bitte iiber , Datei -> Speichern unter” um die Original Datei ElbeDSS.eif in ihrem urspriinglichen Zustand zu bewahren. An-
schliefSend konnen Sie das Elbe-DSS beenden (Datei -> Beenden).
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